
Air Messenger Overview

Air Messenger SNPP is a simple to use application that will allow you to send    Alphanumeric 
Message to Cellular Phones and other Alphanumeric Pagers over the Internet using the SNPP protocol 
(Simple Network Paging Protocol). The use of SNPP allows quick access to a Gateway and special 
functions that are not available via the TAP/IXO protocal such as delivery confirmation and 2-way paging.

Some of the feature of Air Messenger SNPP include the following:

· TCP/IP Compatibility
· SNPP Support
· Advanced SNPP Support
· Message Queuing
· Message Scheduling
· Signature Line
· Easy Of Use

For more information on the Air Messenger LAN Server,    Air Messenger Pro, or other paging 
products, please visit our web site at http://www.cybergs.com/~issonline



General Settings

The General Tab contains general setup information for Air Messenger. The following items can 
be found on this tab.

Signature:
You can use this field to display common information like your name that can be sent at the end 
of each page to indicate from whom the page is from.

Enable Signature:
This option sets the default mode of your signature. Checked indicates enabled. You can also 
disable or enable this option for each page on the Main Screen.

Queue Check Tine:
This is the time in minutes that the message queue gets checked. The queue is used to store 
several messages before they get sent to the Paging Network.

Enable Queue Checking:
This enables Queue Checking, if unchecked then you must manually send your queued 
messages with the Messages|Send Queued Messages Menu Option.

Run In System Try:
When checked, this will minimize Air Messenger to the System Tray instead of the Task Bar. This 
will keep your Task Bar cleaner but still have quick access to Air Messenger.

Transaction Logging:
This option will log all your message transaction between you and the Paging Network.



Adding/Editing Users

The Personal Users window displays the current list of users that are available in the data base. 
From this window you can Add, Delete, or Edit users.

Adding Users:
To add a new user, select the Add Button. A User Data Window will appear. Enter the following 
information.

Name:
This is the users name. This name will be displayed in all the user listings for 
identification purposes.

PIN:
This is the Phone Number or PIN you wish to send the pages to.

Numeric Pager Only:
Check this option if this User is has a Numeric Pager Only. This will make sure you do not
inadvertently send a Alpha Page to a Numeric Pager.

Once the above information has been entered, select OK to add the new user to your list.

Editing Users:
To edit a user, select the user you wish to edit from the list, then select the Edit Button or double 
click on the user. Edit the information in the User Data Window and select OK when done.

Deleting Users:
To delete a user, select the user you wish to delete from the list, then select the Delete Button. 
Enter YES to the confirmation and the user will be deleted.



Sending A Message

The following explains how to send a simple message. There are more advanced features that 
can be used and are explained in the Advanced Topics Area.

To send a simple message, do the following.
1. Enter the message you wish to send in the Message Window.
2. Select the individual users from the User List.
3. Click on the Send Button.

After selecting the Send Button, the message is delivered to the Paging Network, you will receive
a confirmation that the gateway has received your message.



Message Queuing

Message queuing is useful if you plan to send mixed group and individual messages and wish to 
call the Paging Network only once. Air Messenger can automatically check to see if you have any 
messages in the queue at predefined intervals (See Options) to send and if so will send the messages for
you otherwise you will have to manually send them from the Message Menu.

To place messages in the message queue is simple, instead is choosing the Send Page Button, 
Choose Send to Queue Button and the page will be sent to the queue instead of being sent to the Paging 
Network immediately.

You can determine hoe many messages you have in the message queue be looking at the Queue
Status Panel which indicates how many messages are in the queue and when the next auto check will 
occur.



View Logged Data

In order for you to view a log file, you must have enabled the logging feature in the Option 
Window and collected some logged data.

Select View Log from the File Menu. This will display the Log Viewer. With the log viewer you 
have several options to choose from which are listed below. 

Save As:
This option allows you to save the log file for future viewing.

Clear Log:
This option will clear the current log and start a new one.

Print:
This option will print the current log.

Print Setup:
This option will allow you to setup the printer before you print the log file.

Exit:
This will close and exit from the Log Viewer.



Main Screen Overview

The main screen of Air Messenger is where you create and send your messages and are able to 
change your settings, add and delete users and groups. See the following related topics.

Related Topics:

Message Window
Quick Access Buttons
Page Options/Queue Status
File Menu
Edit Menu
Settings Menu
Message Menu



Message Window

The message window is where you type in your message that you wish to send. 
If you make a mistake and wish to clear the Message Window, Click on the Clear Text Button or 

select Clear Text from the Message Menu.
To create a Quick Message, type the message you wish to create and then select the Save 

Message Button of choose Save Message from the Message Menu.



Quick Message Buttons

The Quick Access Buttons allow you to access commonly used menu option with a single mouse 
click. The Quick Access Buttons can be found directly under the Message Window. The following Quick 
Access Buttons are available.

Send Message:
This button will send the current message immediately to the Paging Network.

Send To Queue:
This will send the message to the message queue. See Using Message Queuing under 
Advanced Topics for more information on this subject.

Clear Text:
This will clear the current message that is displayed in the Message Window.



Page Options/Queue Status Panel

The Page Options/Queue Status Panel allows you to quickly enable or disable options that can 
be set on a per page basis. This panel also gives you helpful information on the status of your message 
queue. The following can be found on this panel.

Enable Queue Checking:
This option allows your you to enable or disable automatic queue checking. For more information 
on this topic, see Using Message Queuing under Advanced Topics.

Attach Signature:
This option will send the signature text that you have entered in the Options Screen.

In Queue:
This shows how many message you currently have in your message queue. See Using Message 
Queuing for more information on this topic.

Check:
If you have Queue Checking enabled (See Above), this show the minutes remaining until the next
auto check.



File Menu

The following option can be found on the File Menu.

View Log:
This option will display the Log Viewer. The Log Viewer is covered in more detail under Viewing 
Logged Data.

Shut Down:
This option will terminate the Air Messenger Application.



Edit Menu

The Edit Menu contains message editing commands. The following options can be found on this 
menu.

Cut:
This option will cut the selected text from the Message Window and places it on the Windows 
clipboard.

Copy:
This option will copy the selected text from the Message Window and places it on the Windows 
clipboard.

Paste:
This option will past the any text that is contained on the Windows clipboard to the Message 
Window.

Insert:
This option will insert the current Date/Time in to the Message Window.



Settings Menu

The Settings Menu contains options that alter how Air Messenger operates. The following options
are available from this menu.

Users:
This option will display the User List Window. From this window you will be able to add and edit 
user information. See Adding/Editing Users for more detailed information on this topic.

Paging Companies:
This option will display the Paging Company List Window. From this window you will be able to 
add and edit paging company information. 

Options:
This option will display the options screen, which allows you to alter the way Air Messenger 
operates. For more information, see Setup Topics.

Setup Wizard:
This option allows you to run the Setup Wizard again.



Message Menu

The Message Menu contains option that pertain to sending pages. The following option can be 
found on this menu.

Send Now:
This option will send the current message immediately to the Paging Network.

Send Special SNPP:
This option will allow you to send a message with special delivery instruction to a SNPP provider. 
Only a single user can be selected using this option. The user must also have a provider that 
allows SNPP. This would be identified by the  icon next to the user. See the Send Special SNPP
section for more information. 

Clear Text:
This will clear the current message that is displayed in the Message Window.

Send To Queue:
This will send the message to the message queue. See Using Message Queuing under 
Advanced Topics for more information on this subject.

Send Queued Message:
This option will send all messages that are currently in the message queue to the Paging Network
immediately.

Clear Message Queue:
This option will clear any massages that are queued for delivery.

Cancel Call:
This will cancel a call that is in progress.



Release Notes

01/07/98
1. Fixed display problems when large fonts are used.
2. User display data is update now when provider data changes.
3. Fixed problem when creating new user/group file, user data was stored in group data by mistake.
4. Enhanced some visual displays.

12/28/98
1. Name Change from Quick Page To Air Messenger. This was done so that there would be no confusion 

with LanSoft’s Quick Page Paging Software.
2. Added Length Checking for SNPP Messages.

11/18/98
1. Initial Release



Send Special SNPP

This option dialog box allows you to send a SNPP message with additional parameters. You will 
need to check with the provider of the SNPP Gateway to insure that the correct option have been enabled
in the SNPP Setup of the Provider Data Form.

Priority Level:
This option allows you to set a priority of the message. Their are twelve levels of priority as 
follows:

1. Send Immediately
2. Normal (Default)
3. Five Minutes
4. Fifteen Minutes
5. One Hour
6. Four Hours
7. Twelve Hours
8. Twenty Four Hours
9. Carrier Specific ‘1’
10. Carrier Specific ‘2’
11. Carrier Specific ‘3’
12. Carrier Specific ‘4’

Coverage Area:
This allows you to select an alternate coverage area such as wide area instead of local. Be aware
that the provider may charge accordingly to the area you select.

Do Not Queue:
This option allows you to select No Queuing. Should a message not be able to be delivered 
directly to the pager or phone then the message will not be delivered at all and you would be 
notified as such.

2 Way:
This allows you to setup a two way link between the pager/phone so that you can be eminently be
notified if the receiving pager/phone got message.

Hold Until:
This option allows you to delay a message for delivery until the specified date and time.

Ping:
This option will try to find the unit. A status message will be returned to indicate if the pager or 
phone is on the system and possibility the area it is in.

If any the above commands are not implemented by the provider, a error will be returned indicting
as such.



SNPP Settings Tab

The SNPP Tab allows you to enter settings so you may send messages through an SNPP 
Gateway. This option is useful if you have a provider such as Nextel which allows access to their SMS 
through a SNPP Gateway. You can then send messages from anywhere in the world to a provider over 
the Internet without incurring long distance charges. 

You will need to contact the providers that you will be dealing with to see if they support this 
feature. You will also need to acquire the Gateway Address and Port Name/Number along with the 
features they support.

The following options can be found on this tab.

Company Name:
This is the name of the paging company. This name will be displayed in all the paging company 
listings for identification purposes.

Server:
This is the server address of the Gateway. This will need to be obtained from the provider.

Port:
This is the server port of the Gateway. This will need to be obtained from the provider.

SNPP Options:
These are features that may or may not be supported by a specific provider. For more information
on these options, see Send SNPP Special for more information.

Use SNPP:
This option will enable the use of SNPP.

Note: In order to use the SNPP option, you must have access to the Internet. This can be via dial-up or 
permanent connection. If a large office is wanting to use this option with several SNPP providers and only
a dial-up is available, Air Messenger LAN Server has a proxy option that will allow this feature.



RAS Dialer Settings

The RAS Option TAB allows you to use a Dial-Up Networking connection to send SNPP 
messages to a SNPP Gateway over the Internet. You must have already setup the Dial-Up Connection in 
your Dial-Up Network Folder in Windows 95 be for you can configure this option. The following items can 
be found on this tab.

Network To Dial:
Select from the drop down list the Dial-Up connection to use for sending the SNPP Messages.

Network Password:
This is the password that is required to log onto your Dial-Up connection.

Time Out:
This is the amount of time to wait before Air Messenger determines that it could not connect to 
your Dial-Up connection..

Use RAS Dialer:
This enabled the use of the RAS Dialer. If this option is unchecked, Air Messenger will attempt to 
send SNPP Messages via a local network.



Contacting Information

The following is information on how you can contact Internet Software Solutions.

Internet:
issonline@cybergs.com For Sales Information
http://www.cybergs.com/~issonline WWW Web Page
home.cybergs.com MS Net Meeting

U.S. Postal:

Internet Software Solutions
249 S.35 Street
Springfield, Or 97478




